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Chapter 2

Introducing QuickBooks

Topics
In this chapter, you will learn about the following topics:
e The QuickBooks Product Line (page 7)
e Accounting 101 (page 8)
e QuickBooks Files (page 11)
e Opening Portable Company Files (page 16)
e Restoring Backup Files (page 21)
e QuickBooks User Interface Features (page 25)
e Entering Transactions in QuickBooks (page 28)
e QuickBooks Help (page 33)

QuickBooks is one of the most powerful tools you will use in managing your business. QuickBooks isn’t
just a robust bookkeeping program; QuickBooks is a management tool. When set up and used
properly, QuickBooks allows you to track and manage income, expenses, bank accounts, receivables,
inventory, job costs, fixed assets, payables, loans, payroll, billable time, and equity in your company. It
also provides you with detailed reports that are essential to making good business decisions.

QuickBooks helps small business owners run their businesses efficiently without worrying about the
debits and credits of accounting entries. However, to use QuickBooks effectively, you still need to
understand how QuickBooks is structured, how its files work, how to navigate in the system to do
tasks, and how to retrieve information about your business. In this chapter you’ll learn some of the
basics of the QuickBooks program and then you will explore the world of accounting.

The QuickBooks Product Line

The QuickBooks family of products is designed to be easy to use, while providing a comprehensive set
of accounting tools including: general ledger, inventory, accounts receivable, accounts payable, sales
tax, and financial reporting. In addition, a variety of optional, fee-based payroll services, merchant
account services, and other add-on products integrate with the QuickBooks software.

QuickBooks Desktop vs. QuickBooks Online

Intuit offers two distinctly different ways to use QuickBooks. One version is installed on your local
computer and is referred to as QuickBooks Desktop (QBDT). The other is QuickBooks Online (QBO), a
cloud-based application that isn’t installed on your computer, but is accessed online through a web
browser or app on a smartphone or tablet. The online edition has different, yet similar, features to
QuickBooks Desktop. This book covers QuickBooks Desktop.
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8 Accounting 101

QuickBooks Versions

The QuickBooks Desktop product line includes several separate product editions: QuickBooks Pro,
QuickBooks Premier, QuickBooks Accountant, and QuickBooks Enterprise. The Premier and Enterprise
versions are further broken down into six industry-specific versions for General Business, General
Contractor, Manufacturing & Wholesale, Nonprofit, Professional Services, and Retail.

This book covers the features and usage of QuickBooks Pro and Premier (non-industry specific), since
most small businesses will use one of these editions. We will also occasionally refer to the Accountant
edition, which has additional tools for bookkeepers. Once you learn how to use one of these versions,
you’ll be prepared to use any of the others.

All editions of QuickBooks support multiple users; however, each user must have the same version of
QuickBooks to access the file. Multi-user files must be shared on a dedicated server or be hosted by a
remote service.

While QuickBooks Desktop used to have standalone software downloads, it is now only sold by annual
subscription. The benefits to subscribing include enhanced customer support, an online backup
service, automatic upgrades from version to version, and exclusive features such as Receipt
Management, which allows users to photograph receipts with their mobile devices.

There is also a Mobile App that syncs with QuickBooks Desktop to help you take pictures of receipts
and swipe credit cards in the field.

For a comparison of all products and options, visit https://quickbooks.intuit.com/desktop/.

Accounting 101

Having a basic background in the accounting process will help you learn QuickBooks and run your
business. In this section, we look at some basic accounting concepts and how they relate to
QuickBooks.

Accounting’s Focus

Accounting’s primary concern is the accurate recording and categorizing of transactions so that you
can produce reports that accurately portray the financial health of your organization. Put another way,
accounting’s focus is on whether your organization is succeeding and how well it is succeeding.

The purpose of accounting is to serve management, investors, creditors, and government agencies.
Accounting reports allow any of these groups to assess the financial position of the organization
relative to its debts (liabilities), its capabilities to satisfy those debts and continue operations (assets),
and the difference between them (net worth or equity).

The fundamental equation (called the Accounting Equation) that governs all accounting is:
Assets = Liabilities + Equity, or Equity = Assets - Liabilities.

The General Ledger

Many factors go into making an organization work. Money and value are attached to everything that is
associated with operating a company — cash, equipment, rent, utilities, wages, raw materials,
merchandise, and so on. For an organization to understand its financial position, business
transactions need to be recorded, summarized, balanced, and presented in reports according to the
rules of accounting.

Business transactions (e.g., sales, purchases, operating expense payments) are recorded in several
types of ledgers, called accounts. The summary of all transactions in all ledgers for a company is called
the General Ledger. A listing of every account in the General Ledger is called the Chart of Accounts.

Each account summarizes transactions that increase or decrease the equity in your organization. The
figure below shows a general picture of the effect your accounts have on the equity of your
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organization. Some accounts (those on the left) increase equity when they are increased, while others
(those on the right) decrease equity when they are increased.

Capital Equipment
—_—

Inventory E Loan Interest
Cash Q
U Rent
Investments I
T Wages
Y

So, let’s return to the accounting equation. To understand the accounting equation, consider the
following statement: Everything a company owns was purchased by funds from lenders, or the owner’s
stake in the company.

Account Types and Financial Reports

Each account in the general ledger has a type, which describes what kind of business transaction is
stored in that account. There are primarily five types of accounts: asset, liability, equity, income, and
expense. Assets, liabilities, and equity accounts are associated with the Balance Sheet report, which is
used to analyze the net worth of a business. The income and expense accounts are associated with
the Profit & Loss report (also called an Income Statement), which is used to analyze the operating
profit or loss for a business over a specific time range (month, quarter, year, etc.).

The Balance Sheet report preserves the fundamental accounting equation - Total assets always equal
the total liabilities plus equity, between the accounts. This means that the total of the assets (which
represent what the company “owns”) is always equal to the sum of the liabilities (representing what
the company owes) plus the equity (representing the owner’s interest in the company). Although
income and expense accounts are not directly shown in the accounting equation, they do affect this
equation via the equity account as shown below.

The income and expenses are tracked throughout the year, as business transactions occur, and are
totaled at the end of the year to calculate Net Income (or Loss). Net income (total revenues minus total
expenses) increases the owner’s equity in the business, and net loss (when expenses exceed
revenues) decreases the owner’s equity in the business. Thus, the Income and Expense accounts
indirectly affect the Equity component of the accounting equation of Assets = Liabilities + Equity,
where Equity increases or decreases each year depending on whether the year’s income exceeds
expenses or not.

At the end of the year, the balance of each income and expense account is reset to zero so these
accounts can track the next year’s transactions.

Double-Entry Accounting

Double-entry accounting is the technique that makes the accounting equation work. It divides each
account into two sides. One side is a record of transactions that increase the account, and the other
side is a record of all transactions that decrease the account. One side (the left side) is for debits, and
the other (the right side) is for credits. Depending on the type of account, a debit might increase the
account or decrease it. The same is true of credits. Therefore, debits are not always bad, and credits
are not always good. They are just part of the system of accounting. However, the rule of double-entry
accounting is that total debits must always equal total credits. Every transaction creates a debit in one
or more accounts and a credit in one or more accounts. If the debits and credits for any transaction
are not equal, the transaction has an error or is incomplete.
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Accounting Behind the Scenes

Recording and categorizing all of your business transactions into the proper accounts, summarizing
and adjusting them, and then preparing financial statements can be an enormous, labor-intensive task
without the help of a computer and software. This is where QuickBooks comes in. QuickBooks focuses
on ease of use and hiding accounting details. To make all this possible, QuickBooks uses components
like accounts, items, forms, registers, and lists, which are discussed later in the chapter. Familiar-
looking forms such as invoices, checks, and bills are used for data entry. As you enter data in forms,
QuickBooks handles the accounting entries for you. Thus, business owners can use QuickBooks to
efficiently run a business without getting bogged down with the debits and credits of accounting
entries.

QuickBooks also handles double entry for you. Every transaction you enter in the program
automatically becomes a debit to one or more accounts and a credit to one or more other accounts.
QuickBooks won't let you record the transaction until the total of the debits equals the total of the
credits. This means you can create reports that show the transactions in the full double-entry
accounting format whenever you need them, allowing you to focus on the business transaction rather
than the debits and credits in the General Ledger.

Cash or accrual method, as discussed in the next section, is handled in QuickBooks as a simple
reporting option. You can create reports for either cash or accrual basis regardless of the method you
use for taxes.

As the book introduces new transaction types (e.g., Invoices, Bills, or Checks), the text will include a
section called “The Accounting Behind the Scenes.” For example, when you first learn about invoices
you will see the following message:

The Accounting Behind the Scenes:

When you create an Invoice, QuickBooks increases (with a debit) Accounts Receivable
and increases (with a credit) the appropriate Income account. If applicable, Invoices
and Sales Receipts also increase (with a credit) the sales tax liability account.

Letting QuickBooks handle the accounting behind the scenes means you can focus on your
organization and identify the important factors that will help you succeed. Once you identify these
factors, you can use QuickBooks to monitor them and provide information that will guide you in
managing your operations.

Accounting Basis: Cash or Accrual?

Another critical aspect of accounting is managing for the future. Many times, your organization will
have assets and liabilities that represent money owed to the company, or owed to others by the
company, but are not yet due. For example, you may have sold something to a customer and sent an
invoice, but the payment has not been received. In this case, you have an outstanding receivable.
Similarly, you may have a bill for insurance that is not yet due. In this case, you have an outstanding
payable.

An accounting system that uses the Accrual Basis method of accounting tracks these receivables and
payables and uses them to evaluate a company’s financial position. The accrual basis method
specifies that revenues and expenses are recoghized in the period in which the transactions occur,
rather than in the period in which cash changes hands. This helps you more accurately understand the
true profitability of the business in each period. Assets, liabilities, income, and expenses are entered
when you know about them, and they are used to identify what you need on hand to meet both current
and known future obligations.

In the Cash Basis method, revenues and expenses are not recognized until cash changes hands. So,
revenue is recognized when the customer pays, and an expense is recognized when you pay the bill for
the expense.
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Although certain types of companies can use the cash basis method of accounting, the accrual
method provides the most accurate picture for managing your business. Some organizations are not
allowed to operate as cash basis under IRS regulations. You should check with your tax accountant to
determine which accounting method — cash or accrual — is best for you.

In QuickBooks, you can record transactions such as invoices and bills to facilitate accrual basis
reporting, and still create cash basis reports that remove the receivables and payables. This gives you
the flexibility of selecting one basis for taxes and another for operational reporting, if you wish. For
more information, see page 216.

Imagine Photography Business Scenario

Throughout this book, you will see references to a fictitious company called Imagine Photography.
Imagine Photography is a photography studio that also sells camera equipment. This company uses
QuickBooks for its accounting and business management. Imagine Photography may not be exactly
like your business; however, the examples in this text that focus on Imagine Photography are generic
enough to guide you on your own use of QuickBooks.

Imagine Photography has two locations, one in San Jose and another in Walnut Creek. In order for
management to separately track revenue and expenses for each store, Imagine Photography uses
Classes in QuickBooks. As you proceed through the book, you'll see how each transaction (bill, check,
invoice, etc.) is tagged with what class it belongs to, so that later you can create reports like the Profit
& Loss by Class. Classes can be used to separately track departments, profit centers, store locations,
or funds in any business.

Imagine Photography also needs to separately track revenue and expenses for each job it performs.
When a customer orders a photo shoot, Imagine Photography needs to track all of the revenue and
expenses specifically related to that job so it can look back and see how profitable the job was. This
concept is called Job Costing, and many different businesses need to track jobs in similar ways.

As you think through the examples with Imagine Photography, ask yourself what parallels you see to
your own organization. Certainly, areas such as salaries, supplies, equipment, and others will be
appropriate for your setup, but the names and specifics of the accounts, items, lists, and forms will
probably be different.

QuickBooks Files

Before using QuickBooks, it is important for you to understand how QuickBooks files are structured
and used. QuickBooks has three primary types of files described below. All file types can be opened
using the Open or Restore Company option from the File menu.

1. Working Data Files - These files are used to enter transactions and create reports. These are
also called the Company Files. (File Extension .QBW)

2. Portable Company Files -These files are a compact version of the company data files and are
used to transport the file between computers. These files should never be used to back up your
QuickBooks data because they omit non-financial content such as logos and templates.
Portable files must be “Restored” to a working data file to be used. (File Extension .QBM)

3. Backup Files -These files are a compressed version of the company data files and are used as
backup to safeguard the information. These files cannot be used directly within QuickBooks
and must be “Restored” to working data file format. (File Extension .QBB)

If you name your company file ABC, QuickBooks will store the working data file as “ABC.QBW.” When
you back up your company file using the QuickBooks Backup function, QuickBooks will store your
backup file with the name “ABC.QBB.” If you create a portable data file using the QuickBooks Portable
file creation function, the portable file “ABC.QBM” will be created.
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In addition to the Backup and Restore process, which moves the complete QuickBooks file between
computers, QuickBooks also has a feature called the Accountant’s Copy. This feature enables an
accounting professional to review and make corrections to a special copy of the client’'s company file
while the client continues to work. Then the client can merge the accountant’s changes back into the
original file. See the QuickBooks Help Index for information on this feature.

Important:

Each file type has a specific purpose and should be used accordingly. Working data files
are used to enter data and run reports, backup files are used to safeguard the data,
and portable files are compressed files used to transport data between computers
because smaller files transfer faster.

Updating Files

When you open a company file that was created in an older version of QuickBooks, you will be asked to
update the file to match your more recent edition. Accept all defaults.

Files that have been updated can no longer be opened using the previous version of the software.

Important!

The files that accompany this book were all created using QuickBooks 2020 so that
they would be compatible with the most readily available editions. As you open each
file, you will be asked to update it to match the version installed on your computer.

Opening Recent Files

When QuickBooks opens, you will either see the No Company Open window (see Figure 2-1) or you will
be prompted to enter the password for the last working data file used.

The No Company Open window displays when you are opening QuickBooks for the first time, or if you
closed the working data file before exiting in your last session. By default, the last working data file
used reopens automatically if you closed the QuickBooks program without closing the file.

Double-click on a file to open it.

No Company Open
Select a company that you've previously opened and click Open
COMPANY NAME LAST MODIFIEC FILE SIZE
Intro-20.QBW (0512512020, 02:36 PM 1552 MB “
sample_product-based business.qbw \ 10/07/2019, 02:01 PM 47.41 MB
Edit List

[ Previously Opened Files J

TION:  \\Mac\Dropbox for i lients\Questiva\2020 Files\Quif _2020_Solution_Files\Working Files\

\

Create a Open or restore an Open a e Find a
new company existing company sample file company file

Figure 2-1 No Company Open window

Find a Company File

Click the Find a Company File box to scan your computer for all QuickBooks files (see Figure 2-2).
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Find a Company File

Search for QuickBooks files

NAME TvPE DATE MODIFIED = LOCATION
Infro-20.08M Portable File 627202012055 C\Users\AdmmnstiatonRoyahise S¢
infro-200BM Portabie File 62202012055 . CUsersiAdministratoniDropboxiClie

Ervas

Iniro-20.08M Fortable Fie /212020 12055 atoriDropbaxClie

Inro-20.08M Portabis File /212020 12055
Company File  5/27/2020 8581

Company File  5/2620202521..  CilUsers\Public\Documentsintuf Qu
Company File 52512020 1:545
n-Co. CompanyFlle 52572020 1545

B10MDIOpLAPUE

%

BtonRoyaNise St
Company File /1572019 12:39.

ator

S —— o ’
ey we | EER
Figure 2-2 Find a Company File

Creating a New File

There are four ways to create a new QuickBooks file: Express Start, Detailed Start, Company Based on
an Existing Company, and Conversion from Other Accounting Software. Although it is possible to create
a QuickBooks file relatively quickly using Express Start, we recommend utilizing a 12-Step process for
creating a file to properly set up accounts and account balances. We have placed the chapter that
explains file setup later in the book so you will be able to utilize knowledge gained in earlier chapters.
You can learn more about file setup in our File Setup chapter starting on page 445.

Opening a QuickBooks Sample File

For learning purposes, QuickBooks provides sample data files that allow you to explore the program.
To open a sample data file, follow these steps:

HANDS-ON TRAINING
Step 1. Launch the QuickBooks program by double-clicking the icon on your desktop or

selecting it from the Windows Start menu.

Step 2. If you don’t see the No Company Open window, close the file that opens, or cancel the
password login box.

Step 3. Click Open a Sample file button and select Sample product-based business from the
list. The selected sample file will open with the QuickBooks Information screen (see
Figure 2-3).

QuickBooks Desktop Information

You're opening a QuickBooks
Desktop sample file.

Important: Use this sample file to practice while
you learn QuickBooks Desktop. Don't use it as
your company file.

While you're using this file, QuickBooks Desktop
will set today's date to 12/15/2022

Figure 2-3 Sample File Information Screen

Step 4. Click OK to continue.

Step 5. The sample file you selected will open. If you see the Accountant Center or the
External Accountant message, close the window by clicking the X in the top right
corner. You can uncheck the box that says Show window when opening a company file
and close the window of the Accountant Center, or check Don’t show this again in the
External Accountant window.
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Opening Other QuickBooks Data Files

If you want to open a QuickBooks company file other than the sample data files, follow the steps
below. We will not complete these steps now, but will use a restored portable file in the next section.

1. Launch the QuickBooks program by double-clicking the icon on your desktop or selecting it from
the Window s Start menu. When QuickBooks opens, it launches the data file you most recently
had open when you last exited the program, unless you specifically closed the data file before
exiting.

2. To open a different file, select the File menu and then choose Open or Restore Company (see
Figure 2-4). You can also click the Open or restore an existing company button on the No
Company Open window.

Edit View Lists Favorites Accountant Company

Mew Company..
Mew Company fram Existing Company File...

Open or Restore Company.. h‘
Open Previous Company 3
Qpen Second Company i

Figure 2-4 File menu

3. Inthe Open or Restore Company window, select Open a company file and click Next.

Open or Restore Company

What type of file do you want to open or restore?

@ Open a company file
* Open a regular company file (.qbw)
* Open an Accountant's Copy working file (.qba)

7 Restore a backup copy

* Restore a backup file (.qbb)
» Restore files from an online backup

7 Restore a portable file
» Re-create a company file that was stored as a portable file (.gbm)

7 Convert an Accountant's Copy Transfer File

« Select an Accountant's Copy Transfer File (QBX)
» Convertitto an Accountant's Copy working file(.QBA) and save it

Figure 2-5 Open or Restore Company

4. Use the Look in: field to navigate to the folder on your hard disk where you store your
QuickBooks file (see Figure 2-6).
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Lookin: | QuickBooks 2020 Classroom Files Y
= Recent ltems
* I Desktop
b Network
Quick access T4 Libraries
- %2 Royalwise Solutions Dropbox
3 Alicia Katz Pollock
Desktop @ OneDrive
~— & This PC
n 4 Downloads
Libraries SuDéskiop
3D Objects
Q « Documents
= Questiva
This PC Warking Files
¥
& QuickBooks 2020 Solution Files
A b Music

Figure 2-6 Selecting the folder where the QuickBooks files are stored

5. Select the file from the list of QuickBooks files, then click Open.

Note:

When you open a data file, depending on today’s date, you may see one or more
“Alerts” for learning to process credit cards, pay taxes, or similar activities. Click Mark
as Done when you see these alerts.

Your company file opens, and you are ready to work with QuickBooks.

Opening Multiple Files

It is possible to open two company files at the same time if you are using QuickBooks Accountant or
Enterprise. However, the activities that can be performed in the second file are very limited. We
recommend that you use one file at a time by closing a file before opening or restoring a different file.

Closing QuickBooks Files

Close the company data file by selecting Close Company from the File menu (see Figure 2-7). Skip this
step to open this data file automatically the next time you start the QuickBooks program.

Edit Wiew Lists Favorites Accountant Company

Mew Company... |
Mew Company from Existing Company File_.

QOpen or Restore Company... I Ir}

Open Previous Company 3
Open Second Company

Back Up Company 3
Create Copy...

Close Company h_

Figure 2-7 Close Company File option

Closing the QuickBooks Program

Just as with any other Windows program, you can close the QuickBooks program by clicking the Close
mepg  button, which looks like an X, at the upper right hand corner of the
Close QuickBooks 2| QuickBooks window, or by selecting Exit from the File menu.

The Exiting QuickBooks window appears to confirm that you want
to exit the QuickBooks program, as opposed to closing a window

Close a full-screen window ]

ACCOUNES Activties

Figure 2-8 Clo—sing QuickBooks and window s
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in QuickBooks. You can disable this message by checking the box next to Do not display this message
in the future (see Figure 2-9).

Exiting QuickBooks Desktop

g Are you sure you want to exit QuickBooks Desktop?

Do not display this message in the future
e

Figure 2-9 Exiting QuickBooks window

QuickBooks Updates and Releases

Occasionally, errors are found in the QuickBooks software after the product is released for sale. As
errors are discovered, Intuit fixes the problem and provides program “patches” via the Internet. Each
patch increases the Release Level of the QuickBooks application. To see what release level of the
software you have, press Ctrl+1 (or F2) while QuickBooks is running. At the top of the window, you will
see the QuickBooks product information including the release level.

| Product  QuickBooks Accountant Deskiop 2021 Release R3P |

Figure 2-10 Product information window showing version and release

This book is based on QuickBooks Accountant 2021 Release R4P. You are likely to have a different
release and may see some slight differences compared to the screenshots in this book.

To patch your software with the latest maintenance update, download it by selecting the Help menu
and then choosing Update QuickBooks. Follow the instructions on these screens to download and
install maintenance releases in QuickBooks via the Internet.

Opening Portable Company Files

Portable Company Files are compact company data files that can be easily transported. The exercise
files that accompany this book are Portable Company Files. You will need to open these exercise files
at the start of each chapter and each problem.

Important:

When you move a data file from one computer (computer A) to another (computer B),
any data you enter on computer B will cause the file on the computer A to become
obsolete. Take care to make sure you are always working in the most recent data file.

HANDS-ON TRAINING
To open portable files follow the steps below.

Step 1. Select the Open or Restore Company option from the File menu.

Step 2. QuickBooks displays the Open or Restore Company window (see Figure 2-11). Select
Restore a portable file (.QBM) and click Next.
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Open or Restore Company

What type of file do you want to open or restore?

7 Open a company file

« Open a regular company file (.qbw)
» Open an Accountant's Copy working file (.qba)

Restore a backup copy

« Restore a backup file (.qbb)
« Restore files from an online backup
Restore a portable file

é « Re-create a company file that was stored as a portable file (.gbm)

7 Convert an Accountant's Copy Transfer File
« Select an Accountant's Copy Transfer File (.QBX)
« Convert it to an Accountant's Copy working file(.QBA) and save it

Figure 2-11 Open or Restore Company window

Step 3. QuickBooks displays the Open Portable Company File window (see Figure 2-12).
Navigate to the location where you have saved your exercise files. Once you are
viewing the contents of the correct folder, select Intro.QBM and click Open.

ab Open Portable Company File x
Look in: QuickBooks 2020 Classroem Files Lt i
‘ Name Date modified Type Size
“intro-20.QBM 5/25/2020 3:19 PM QuickBooks Portable C... 989 KB
Quick access
Desktop
"
Libraries
This PC
Network  File pame: Intro-20.QBM 5 | open |
Files of type: QuickBooks Partable Company Files (*.QBM) 3 | cancel 7‘
Help

Figure 2-12 Open Portable Company File window

Step 4. Next you will need to tell QuickBooks where to save the working file that will be created
from the portable file (see Figure 2-13). Click Next in the Open or Restore Company
window to continue.
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Open or Restore Company x

Where do you want to restore the file?
% In the next window, you will choose the location where you want to restore the file. As
the file restores, it is converted to a company file with the extension .qbw.
Important: If you don't want to overwrite your existing company file, rename the file in

the next window. For example, you may want to add a date or version number such as
mycompanyname-Jan2-2007.qbw or mycompanyname-v2.qbw.

I

Back m Finis Help Cancel

Figure 2-13 Open or Restore Company Location

Step 5. The Save Company File As window displays (see Figure 2-14). Decide where you will
save this file and the other files you'll create while using this book. When you have
navigated to the appropriate folder, click Save.

qb Save Company File as X

Save in: QuickBooks 2020 Classroom Files <| edm@y

~

‘ Name Date modified Type

No items match your search.
Quick access

Desktop
m
Libraries

>

—

This PC

Network
gr ] »
File name: Intro-20.QBW - |

Save

Save as type: QuickBooks Files (*.QBW) i | Cancel

Help

Figure 2-14 Save Company File As window

Step 5. The QuickBooks Desktop Login window opens (see Figure 2-15). The password to this
and every exercise file in this book is Questiva20. The password is case sensitive, so

make sure you capitalize the first letter Q in Questiva20. Enter Questiva20 in the
Password field and click OK.
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QuickBooks Desktop Login x

You need to log in as QuickBooks Desktop Administrator to proceed. Please
enter the admin (owner) password for the company:

Imagine Photography - Intro Chapter

Password: || | forgot my password

Passwords are case sensitive.

OK \ Cancel Help

Figure 2-15 QuickBooks Desktop Login window

Note:

Every QuickBooks file is required to have a complex password. It must be at least 7
characters long and contain at least one uppercase letter and one number. Although we
use the same password for all the exercise files in this book, we recommend that you
use a different password for your own or your employer’s QuickBooks file. For more on
passwords see page 482.

Step 6. When you open each file for the first time, you will receive a message to update the
file, as shown in Figure 2-16. Click Update Now.

Update Your QuickBooks Desktop Company File

@ Guiickbooks

Let's update your company file to the newest version
of QuickBooks Desktop.

Just to be safe, we'll make a backup copy of your company file before we get started.
Your backup copy will be saved here:

C:\Users\

Change this defautt location

ﬂ Important: Once you update, you won't be able to open your company file in an older version

Cancel Update Update Now

Figure 2-16 Update your file to the latest version

Step 7. Once you see the QuickBooks Desktop Information window saying that the Portable
company file has been successfully opened, click OK to continue.

Step 8. Once the Intro.QBW company file finishes opening, you will see the Home page.

Creating Portable Company Files

You can also create a Portable file using the following steps:

HANDS-ON TRAINING

Step 1. Select the Create Copy option from the File menu (see Figure 2-17).
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Edit Miew Lists Favorites Accountant Company Customers

Mew Company...

Mew Company from Existing Company File. .

Dpen or Restore Company... I Insights

Dpen Previous Company 3

Open Second Company

Back Up Company 3 T
Coesecon h R

Close Company Purehase

Figure 2-17 Create Copy

Step 2. The Save Copy or Backup window displays. Select the Portable company file option
and click Next.

What type of file do you want to save?

7 Backup copy
Create a backup copy of everything you need to re-create your company file in case
of accidental loss or damage to your data.

@ Portable company file
Create a compact version of your company financial data that you can e-mail or
temporarily move to another computer.

O Accountant's Copy
Create a compact version of your company file. Your accountant will use it to make
adjustments that you can importinto your file later.

e: To send this file to an Intuit web server, click Cancel now and go to File >
Accountant's Copy > Send to Accountant.

Help me choose

Figure 2-18 Save Copy or Backup window

Step 3. The Save Portable Company File window appears. The default file name in the File
name field is the same as the working file name with “(Portable)” added to the end.
Navigate to your desired file location and click Save.

Step 4. The message shown in Figure 2-19 will appear before the portable file is created. Click
OK to continue.

Close and reopen

file before creating a portable company file.

Figure 2-19 Message for creating portable company file

A QuickBooks must close and reopen your company

Step 5. QuickBooks displays the QuickBooks Desktop Information dialog box (see Figure 2-20).
Click OK to return to the working data file.
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QuickBooks Desktop Information

. QuickBooks has saved a portable file
4 / version for Academy Photography -
~ Intro Chapter to
\\Mac\Home\Desktop\Questiva\Working
Files\QuickBooks 2020 Classroom
Files\Intro-20 (Portable).QBM.

Figure 2-20 Message that the Portable File has been successfully created

Restoring Backup Files

When working with important financial information, creating backup files is a crucial safeguard against
data loss. Every business should conduct regular backups of company information. QuickBooks has
useful tools to automate this process.

In the event of an emergency, you may need to restore lost or damaged data. For example, if your
computer’s hard drive fails, you can restore your backup onto another computer and continue to work.

Note:
Portable files should never be used as a substitute for backup files. Backup files are
larger than portable files and hold more information about the company.

Backing Up Your Data File

Backing up your data is one of the most important safeguards you have to ensure the safety of your
data, and should be done daily.

HANDS-ON TRAINING
Step 1. To back up your company file, select Create Copy from the File menu.
Step 2. Choose Backup copy from the Save Copy or Backup window (see Figure 2-21). Click
Next.

Save Copy or Backup x

What type of file do you want to save?

@ Backup copy
Create a backup copy of everything you need to re-create your company file in case
of accidental loss or damage to your data.

7 Portable company file
Create a compact version of your company financial data that you can e-mail or

temporarily move to another computer.
g 7 Accountant's Copy

Create a compact version of your company file. Your accountant will use it to make
adjustments that you can import into your file later.

To send this file to an Intuit web server, click Cancel now and go to File >
Accountant's Copy > Send to Accountant.

Help me choose

Figure 2-21 Save Copy or Backup window
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Step 3. You are given the option to save the backup to a local storage device, such as a
removable hard disk or a network folder. There is also an option for online backup
using a fee-based service available from Intuit. Online backup is a good option for
many companies who require offsite backups.

Choose Local backup and click Next.

Step 4. The Backup Options window is displayed (see Figure 2-22). Under the Local backup
only section, click the Browse button.

Backup Options x

Use this window to set default options for your manual and automatic backups.
LOCAL BACKUP ONLY

Tell us where to save your backup copies (required)

Browse...

+ Add the date and time of the backup to the file name (recommended)

+ Limitthe number of backup copies in this folder to 3

ONLINE AND LOCAL BACKUP

v Remind me to back up when | close my company file every 4 times.

Select an option to verify that your company data is OK (thatis, not corrupted) when
you save.

@ Complete verification (recommended)
) Quicker verification

No verification Help me choose

Figure 2-22 Backup Options window

Step 5. Select the folder where you want to store your backup file (see Figure 2-23). You
should store the backup files in a safe location, preferably on a different drive than
your working data file. That way, if the drive with the working file is damaged, the
backup will still be available.

Browse for Folder x

Select a location for your backups

| FreeAgent GoFlex Drive (F:) |

(&5 Control Panel -
*3, Homegroup
4 M Computer
& os ()
ey DVD RW Drive (D:)
g FreeAgent GoFlex Drive (F:)
124 Photo Stream

«

[ OK ][ Cancel ]

Figure 2-23 Backup options Browse for Folder window
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Step 6. When finished, click OK.

Step 7. The Save Copy or Backup window is displayed (see Figure 2-24). You can save a
backup now, schedule future backups, or both. Select Only schedule future backups
and click Next.

Save Copy or Backup x

When do you want to save your backup copy?

% ) Save it now

) Save it now and schedule future backups

@ Only schedule future backups

Note: If you are saving your backup copy to a removable storage device such as a CD
or USB flash drive, insertthe CD or connect the device now.

Figure 2-24 Save Copy or Backup window

Step 8. Select New under the Back up on a schedule area.
When do you want to backup your company file?

BACK UP AUTOMATICALLY:

Save backup copy automatically when | close my company file every times

Click Options to view or change where the automatic

g f Options
backup copies will be saved. :

BACK UP ON A SCHEDULE:

g Click New to schedule regular backups of your company file.

New...

Figure 2-25 Save Copy or Backup window

Step 9. The Schedule Backup window appears (see Figure 2-26). Enter a descriptive name for
the backup, the location of the folder to contain the backups, and the time when the
backup file will be created.
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Schedule Backup x

DESCRIBE THE BACKUP TASK YOU WANT TO SCHEDULE:
Description  y40ngay Night Backup

Location gy Browse...

Number of backup copies to keep
SELECT THE TIME AND DAY YOU WANT TO SAVE THE BACKUP:

Starttime

Run this task every 1 = weeks on:
v Monday

Thursday

01 ~ - 00 ~ AM ¥

Tuesday Wednesday
Friday Saturday

Store Password...

Figure 2-26 Schedule Backup window

Step 10.
Step 11.

Step 12.
Step 13.

Step 14.

When finished, click OK to close the Schedule Backup window.

The Store Window s Password window opens. Enter your Windows username and
password and click OK.

Click Finish to close the Schedule Backup window.

If necessary, click OK to close the QuickBooks: Backups have been scheduled as
specified window.

If necessary, click No, Thanks for the offer to try Online Backup.

Restoring a Backup File

HANDS-ON TRAINING

Follow these steps to restore the QuickBooks backup file you just created:

Step 1.
Step 2.

Step 3.

Step 4.

Step 5.
Step 6.

Select the File menu and then choose Open or Restore Company.

Choose Restore a backup copy from the Open or Restore Company window and click
Next.

In the Open or Restore Company window you can specify whether the file is stored
locally or through Intuit’s fee-based Online Backup service. Choose Local backup and
click Next.

The Open Backup Copy window allows you to specify where your backup file is located.
Navigate to the folder that contains the file, select it and click Open.

The Open or Restore Company window displays. Click Next.

The Save Company File As window allows you to specify where to restore the working
files. Navigate to the appropriate folder and click Save. QuickBooks will then restore
your backup file in the folder you specified. You may be prompted to enter a password.
When QuickBooks restores the file, it creates a .QBW file.
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Step 7.
(see Figure 2-27).

QuickBooks Information

'0' Your data has been restored successfully.

Figure 2-27 After restoring backup file

After completion, a window displays that the new file has been successfully restored

Note:

Done when you see these alerts.

When you restore a data file, depending on today’s date, you may see one or more
alerts for learning to process credit cards, pay taxes, or similar activities. Click Mark as

QuickBooks User Interface Features

QuickBooks provides a number of shortcuts and tools that assist the user in entering information and
transactions. You should become familiar with these features so you can get to a task quickly. There
are various methods of accessing the data entry windows: the Home page, Snapshots, Menus,

QuickBooks Centers, Icon Bar, and Shortcut Keys.

Home Page

As soon as you open a company file, QuickBooks displays the Home page (Figure 2-28). The Home
page is broken into five sections, each dealing with a separate functional area of a business: Vendors,
Customers, Employees, Company, and Banking. Each area has icons to facilitate easy access to
QuickBooks tasks. The Home page also displays a workflow diagram showing the interdependency

between tasks.

Tip:

Click on each of the area’s header buttons to open the corresponding Center.

= Home
VENDORS COMPAN
By y ® = |
Purchase Receive Enter Bills Manage Chart of Inventory
Orders Inventory Against Sales Accounts Activities
Inventory Tax
@ Items & Order
Enter Bills Pay Bills Senvices Checks
CUSTOMERS
% D Calendar
Sales & Create Sales
Orders Accept Receipts
Credit Cards
=N
B &2 @)
Estimates Create Receive Record Reconcile
Invoices Payments Deposits
& & &8
Statement Statements Refunds ™
Write Check
Charges & Credits Checks Register
EMPLOYEES
N S &- g =
Print Enter Credit
Tum On Enter Pay Pay HR Essentials Checks  Card Charges
Payroll Time Employees Liabilities and Insurance

Figure 2-28 QuickBooks Accountant 2021 Home page—your screen may vary
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To start a task, just click on its icon on the Home page. If you close the Home page, it can be opened
by clicking on the Home icon on the Icon Bar, or by selecting Home Page from the Company menul.

Icon Bar

The QuickBooks Icon Bar allows you to select centers, activities and available services by clicking icons
on the bar (see Figure 2-29). For example, you can open the Home page by clicking Home on the Icon
Bar.

Click the Collapse Arrow at the top of the blue Icon Bar to shrink it, giving you more workspace area.
The Icon Bar can also be moved to the top of the screen by clicking the View menu.

agine Photogiaphy - o Chapder - OuickBodks Accountant Doskiop 2020 - [Horme | _®x
mpany Cyslomers Vendgrs Emplosees Banking Reporis Window Lelp
nsipn
Sio6Rs S
Collapse =3 > & 5"
Arrow Recetve : Chatof merion
Inventory Against s Accounts Achies
@ % s’
Enter s Payils Sanices
CUSTOMERS E‘
B Catncar
Icon Bar
z
= 2
: @
&5 E] ] & ;
estmates Creat Record Reconciie £
b Deposs H
5
= = b = =
— sttamart Retunas e
Charges Scmans s (o
& ® L pant
TumOn Ener Pay Pay chec
Payrell Time Empioyess Liabites
COVID-19 Resources
& Tum on Payol

Figure 2-29 The Icon Bar

Centers

QuickBooks Centers summarize pertinent information and transactions in one place. There are several
Centers for specific tasks. Centers can be opened from the Menus, Home page buttons, and the Icon
Bar.

Customer, Vendor, and Employee Centers are very important since they provide the only way to access
a list of your customers, vendors, and employees. These three lists are referred to as the Center-based
Lists. For example, when you click on the Customers section label in the Home page, the Customer
Center opens to show each customer’s balance, their general information, and all their transactions
(see Figure 2-30).

&, tiew Custonec 8.0 ¥ () New Tronsactons ¥ & g v [ Eacel™ [ Woro v S bcome Tracier
. A
Customer Information ] -
Active Customers - > . . . s0n555.0225
ums Bob Mason s Erat b3SON@MN com e
e Indidust
| « Academy Training instte 000 o a0
net20

+ Anderson Wedcing Pianners 24054 W

+Kumaz Satiang Naveen 24954 376 Pine St #5E

+Wison, Saran ana ichael 000 HopmEREART
+BermyRon 000 v
[ Com Msta Ui Transacuons | Conads | Topas Notsg  SentEmai

+Branch Opening 195000
|+ Easley Business Senices 000 MTRIANG = - % o B
+Feng. Tim 000 -
+ Gamison, John 000 involce 2021104 othazaz1 11000 Accounts Recevadle 77047

+Family Porrai 000 ineics 3097 121102020 11000 - Accounts Recsable 0130
T -
« Hekowsky & Company 000
« Miranda's Comer 118180 :
+ Homs Consuiting 000
- Ortega Senvices 000
+ Peligini George 000

+ 1264 Wilkes R 000

24286 Lake Drive 000
oPerez Jory 000
« Stevens Plerce & Assodales. CPAs 000
+Tucker and Jonnson,inc 000

Figure 2-30 Customer Center
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Other Centers include the Bank Feeds Center, the Report Center, and the Doc Center. These Centers
will be addressed later in this book.

Calendar

You can view transactions on a Calendar. The calendar displays transactions on the Entered date and
the Due date.

Note:

The Entered date is not the date the transaction is entered into QuickBooks. It is the

date on each transaction form. If you create an invoice on January 5, 2021 and enter
the date 1/6/2021 in the date field, the invoice will show on January 6, 2021 on the
Calendar.

HANDS-ON TRAINING
Step 1. Click the Calendar icon on the Company section of the Home page.

Step 2. The Calendar window opens (see Figure 2-31). When finished, close the Calendar
window.

M Upcoming: Next 7 days (0)

1 2 * 10000
= TRANSACTIONS {0)

¥ Due: Past 60 days (0)

*T0000)
~ TRANSACTIONS 0] os

24 25 26 27 28 29 Entered 1) 30 Entered 2}

vy 75, 2001 AR e

Figure 2-31 QuickBooks Calendar - your screen may vary

Income Tracker

uNPAR w0

UNSILLED
0.00 0 0.00 0.00
QESTIMATES  SALES ORDERS OTIME & EXPENSES 0 OVEROUE
Al

[~ Al - 8 Al v owe Al -
O | cusr wusen v = . = -
e o N ) ) ) N
] Mason, Bob Invoice 2021-104 1/972021 2182021 776.47 7647 Open

[] Miranda's Comer Invoice 2021103 1182021 272021 1,191.80 1,191.80 Open
[] Ctuz, Maria'Branch Opening  Invoice 2021-102 11612021 252021 500.00 500,00 Open
[] Cruz, Maria:Branch Opening Invoice 2021101 1152021 242021 570.00 570,00 Open
[[] Anderson Wedding Pianne. . Invoice 4003 12212020 1202021 24954 24954 Open

] Mason, Bob Invoice 3947 121872020 17,2021 40139 40139 Open

Figure 2-32 Income Tracker - your screen may vary

The Income Tracker provides a fast way to see the status of your revenue-based transactions. Click on
the colored boxes in the Money Bar to filter the list for Estimates, Sales Orders, Unbilled Time &
Expenses, open and overdue Invoices, and recent Payments.

Snapshots

The Snapshots Center is a single-screen summary of different aspects of a company. Charts such as
Income and Expense Trends, Previous Year Income Comparison, and Expense Breakdown are
displayed along with important lists such as Account Balances and Customers Who Owe Money. The
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Snapshots can be easily customized to show the information that is of most interest to you and your
company.

Company | payments || Customer T —
AddContentd |  Restore Default How do | customize this page? | & Print ~ |

Income and Expense Trend ~ X Prev Year Income Comparison ~ X Customers Who Owe Money =
$in1000s This year-to-date | All - Yearly "

80 Mackey's Nurseryand G... | 11/0422019  13,900.00

50

'y

Pretell Real Estate 110972019 502650

x
7 $ini10008 Allard, Robert 0922712018 14510.00
Cook, Brian 1nazote 939733

500
a0
2 300 Hendro Riyadi 11182019 422300
% o Vitton, David 111202019 70000
. ‘ Teschner, Anton 1211372019 565.95
L Robson, Darci 121152018 1242098
B 50 e s =

0
N Ag S 0= Nov D Melton, Johnny 12202018 861864

A3 A6 2015 216 20170 2018 Burch, Jason 122612019 100500 |

. ncome N Expense

W Prior Year(s) W Current Year Receive Payments

Account Balances ) T CE ey s + x  Prev Year Expense Comparison v x
Al N Yearly

$in1000s

This yearto-date v

* Accounts Receivable 93,007.93 o
© Checking 46,969.10

* Accounts Payable 26,636.92 z
* Savings 1791019
Sagids _ 200 v

ESETEIETS
Figure 2-33 Snapshots - your screen may vary

Cook, Brian

Entering Transactions in QuickBooks

Each time you buy or sell products or services, pay a bill, make a deposit at the bank, or transfer
money, you enter a corresponding transaction into QuickBooks.

Each activity should have one action. For example, a customer paying off several invoices will still have
ONE Receive Payment form for the ONE check they handed you (more about that on page 63).

Forms

In QuickBooks, transactions are created by filling out familiar-looking Forms such as invoices, bills, and
checks. When you finish filling out a form, QuickBooks automatically records the accounting entries
behind the scenes. Most forms in QuickBooks have drop-down lists to allow you to pick from a list
instead of spelling out the name of a customer, vendor, item, or account.

By using forms to enter transactions, you provide QuickBooks with all of the details of each
transaction. For example, by using the Enter Bills form, QuickBooks tracks the vendor balance, the due
date of the bill, the discount terms, and the debits and credits in the General Ledger. This is a good
example of how QuickBooks handles the accounting behind the scenes.

Before QuickBooks, many bookkeepers used Journal Entries to manually enter accounting
transactions. Journal entries limit QuickBooks from providing management information beyond just the
debits and credits. If a form is available that achieves your goal, use it!

HANDS-ON TRAINING
Step 1. Click the Enter Bills icon in Vendors section of the Home page (see Figure 2-34).
&
Purchase Receive

Orders Inventory

®

Enter Bills

=

Figure 2-34 Enter Bills on the Home page

Step 2. Click the Previous button in the upper left corner of the Enter Bills window until you see
the previously entered bill (see Figure 2-35).

Step 3. Click the down arrow next to the vendor field to see the drop-down list for vendors.
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Step 4. Click the Calendar icon next to the date to see the Date Picker.
Step 5. When finished exploring, click the Revert button in the bottom right, which will return
the transaction to the last saved state.
Step 6. Close the Enter Bills window.
= Enter Bills pepla s

=a
'Y
>

Main Reports

« 8 B R Qoo @ § B O B @

Find New Save Delete QMemon:e Print Attach Select Enter Clear Recalculate Pay
o o File PO Time Splits Bill

+| Bill Received

[ Dropdown Arrow J ( Date Picker ' reneer

\[ l 4
N SUMMARY
PN rigue Rentals -] owm 01/30/2021
Al e e eeep——————————— Phone 925-555-3479
= REF. NG 98527 750.00
sopezec | Rodriguez Rentals Open balance 73000
33 Wheeler Rd AMOUNT DUE  [750.00 POs to be received 0

Walnut Creek, CA94326

DUE 02/14/2021 &

TERMS Net 15 - DISCOUNT DATE
MEMO Lighting Rental [ HIStory Pane
RECENT TRANSACTION @
Expenses $750.00 | ltems $0.00
01/30/21 Bill 750.00
62600 - EquipmentR... San Jose
[ Action Buttons l P
NOTES

Save & Close { Save & New ‘ Revert

Figure 2-35 Anatomy of a Form

Lists

Lists are one of the most important building blocks of QuickBooks. Lists store information that is used
again and again to fill out forms. For example, when you set up a customer, including their name,
address and other details, QuickBooks can use the information to automatically fill out an invoice.
Similarly, after an Item is set up, QuickBooks automatically fills in its description, price, and associated
account information. This helps speed up data entry and reduce errors.

Note:

There are two kinds of lists — menu-based and center-based. Menu-based lists are
accessible through the Lists menu and populate the fields on forms. Center-based lists
include the Customer Center and Vendor Center, discussed on page 26.

Lists can be viewed by selecting an icon from the Home page (for example, the Items & Services
button), choosing an option from the Lists menu, or viewing a list through one of the various
QuickBooks Centers.

Accounts

QuickBooks efficiently tracks all of your business transactions by categorizing them into Accounts in
your General Ledger. The Chart of Accounts is the list of these accounts.
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HANDS-ON TRAINING

Step 1. To display the Chart of Accounts, click the Chart of Accounts icon on the Home page.
Alternatively, you could select Chart of Accounts from the List menu, or press Ctrl+A.

Step 2. Scroll through the list. Leave the Chart of Accounts open for the next exercise.

By default, the Chart of Accounts is sorted alphabetically within each account type (see Figure 2-36). If
you are using Account Numbers, the categories are sorted by account number.

Use the Search Box at the top to quickly find the account you need.

The Name column shows the account names that you assign. The Lightning Bolt indicates Bank Feed
connectivity. The Type column shows their account type. The Balance Total column shows the
balances for asset, liability, and equity accounts (except Retained Earnings). The Attach column shows
if there are attached documents.

8 Chart of Accounts -
Look for account name or number
" £iT T T
e S ST
+ 10200 - Money Market Bank 12,100.00 '
+ 10300 - Savings Bank 500.00
+ 10900 - Journal Entries. Bank 0.00
+ 11000 - Accounts Receivable Accounts Receivable 4,569.20
+ 12000 - Undeposited Funds Other CurrentAsset 0.00
+ 12100 - Inventory Asset Other CurrentAsset 6,472.23
+ 12800 - Employee Advances Other CurrentAsset 0.00
+ 13100 - Prepaid Insurance Other CurrentAsset 0.00
+ 15000 - Furniture and Equipment Fixed Asset 13,250.00
< 15200 - Buildings and Improvements FixedAsset 0.00
+ 15600 - Land FixedAsset 0.00
+ 15900 - Leasehold Improvements FixedAsset 0.00
+ 16400 - Vehicles FixedAsset 0.00
17000 - Accumulated Depreciation Fixed Asset -1,325.00
+ 18700 - Security Deposits Asset OtherAsset 0.00
20000 - Accounts Payable Accounts Payable 750.00
+ 22000 - National Bank VISA Gold Credit Card 0.00
24000 - Payroll Liabilities Other Current Liability 368.00
224010 - Company Payroll Taxes Payable Other Current Liability 368.00
+24020 - Employee Payroll Taxes Payable Other Current Liability 0.00
©24030 - Other Payroll Liabilities Other Current Liability 0.00
© 24200 - Line of Credit Other Current Liability 6,700.00 v
Account v  Activities v Reports v Attach

Figure 2-36 Chart of Accounts List

Registers

Each asset, liability, and equity account (except Retained Earnings) has a Register. Registers allow you
to view and edit transactions in a single window. Income and expense accounts do not have registers;
rather, their transactions must be viewed in a report.

HANDS-ON TRAINING

Step 1. To open the Checking account register, double-click on 20100 Checking in the Chart
of Accounts list.

Step 2. The Checking register opens (see Figure 2-37). Scroll through the register.
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= 10100 - Checking - %
@ Goto.. | &) Print.. | [ Edit Transaction [) QuickReport [2) Setup Bank Feeds
A v
01/20/2021 6003 Wong & Son Video 142.00 14,212.48 -
BILLPMT 20000 - Accounts Payable Video Production Costs
01/20/2021 6004 Ace Supply 12348 14,089.00
BILLPMT -split- Acct# 43-234
01/30/2021 329 National Bank 2,152.00 11,937.00
CHK 22000 - National Bank VISAGold  1234-1234-1234-1234
02/07/12021 330 Nellis Distributing 375.00 11,562.00
BILLPMT 20000 - Accounts Payable
30720200 | - 'l
i v
apilts ENDING BALANCE 11,562.00
A-Line
Sortby  Date, Type, Number/Ref ~ Restore

Figure 2-37 Checking account register

Step 3. Close the Checking account register by clicking the Close button in the upper right
corner.
Step 4. Double-click the 40000 Services account. You may need to scroll down. This is an
Income account.
Step 5. Instead of opening a register, QuickBooks opens a QuickReport (see Figure 2-38).
Step 6. If necessary, change the Dates field to All and click Refresh.
Step 7. Close the report.
Step 8. Close the Chart of Accounts.
=2 Account QuickReport -0 %
Customize Report Comment on Report S Memorize Print v E-mail v Excel v Hide Header Refresh
Dates Custom * From 01/01/2021 B To 06/01/2021 & SortBy Default -
Report Basis: @ Accrual Cash Show Filters
8:14PM Imagine Photography - Intro Chapter
osm20 Account QuickReport
Accrual Basis January 1 through June 1, 2021
Type Date Num Name Memo Split Amount
40000 - Services
P invoice 01/05/2021 2021-101 Cruz, Maria:Branc... Qutdoor Pho... 11000 - Acco... 380.00 ¢
invoice 01/05/2021 2021101 Cruz, Maria:Branc... Photo retouc. 11000 - Acco... 190.00
Invoice 01/06/2021 2021-102 Cruz, Maria:Branc... Photographer 11000 - Acco... §00.00
Invoice 01/09/2021 2021-104 Mason, Bob Indoer Studi. 11000 - Acco... 285.00
Iinvoice 01/08/2021 2021-104 Mason, Bob Photo retouc... 11000 - Acco... 380.00
Invoice 0111372021 2021-1058 Cruz, Maria:Branc... Indoor Studi. 11000 - Acco... 380.00
Invoice 0111372021 2021-108 Cruz, Maria:Branc... Photographer 11000 - Acco §00.00
Total 40000 - Services 2,615.00
TOTAL 2,615.00
Figure 2-38 A QuickReport
ltems

ltems are used to track a company’s services and products. Since every business has its own unique
set of products and services, QuickBooks needs to be customized by creating items for everything you
buy and sell. For more detail on items and the different item types, see page 289.

Iltems are necessary in order to use sales forms in QuickBooks (e.g., Invoices and Sales Receipts). On
an invoice, for example, each line has an item representing a product, service, discount, or sales tax.

When you define items, you associate them with accounts in the Chart of Accounts. This connection
between item names and accounts is the “magic” that allows QuickBooks to automatically create the
accounting entries behind each transaction.
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For example, Figure 2-40 displays the ltem List. Take a look at Camera SR32, for example. It is
associated with a Sales Income account, Inventory Asset, and Cost of Goods Sold in the Chart of

Accounts. Every time the Camera SR32 item is added to an invoice, the dollar amount increases the
Sales account in the Chart of Accounts, and moves its original cost from Inventory to Cost of Goods.

HANDS-ON TRAINING

Step 1.

nage
ples
rax

Items &
Services

To see what items are available in the file, click the Items & Services icon on the Home
page in the Company section (see Figure 2-39). Alternatively, you could select ltem List
from the Lists menu.

-0 %

Inventory
Activities

Order
Checks

Calendar

Figure 2-39 Items & Services button on Home page

Step 2.
=

Look for

+ Outdoor Photo Session
+ Photographer

+ Retouching

+ Camera SR32

+ Case

< Frame 5x7

+Lens

< Photo Paper

< Premium Photo Package
+ Standard Photo Package
< Bad Debt

<+ Bounce Chg

+ Contra Costa

< Out of State

+ Santa Clara

Figure 2-40 shows the Item List. Double-click the Camera SR32 item.

Item List

in Allfields

Outdoor Photo Session
Photographer

Photo retouching senvices

Supra Digital Camera SR32

Camera and Lens High Impact Case
Picture Frame - 5'x 7' Metal Frame
Supra Zoom Lens

Standard Photo Paper, Glossy, 8.5x11%, 7 Mil, Pack...

Premium Package of P g from

- Indoor Photo Session | Indoor Studio Session senice |40000 - Senvices | || s |

Service
Service
Service
Inventory Part
Inventory Part
Inventory Part
Inventory Part

Non-inventory Part

Standard Package of Photography from Session

Bad Debt - Write off
Return Check Fee
Contra Costa County Sales Tax

Out-of-state sale, exempt from sales tax

Santa Clara County Sales Tax

Non-if y Part
Non-inventory Part
Other Charge
Other Charge
Sales Tax Item
Sales Tax Item
Sales Tax Item

Search within results

40000
40000
40000
45000
45000
45000
45000
45000
45000
45000
60300
45000
25500
25500
25500

- Senvices
Services
- Senvices
Sales
- Sales
Sales
- Sales
Sales
- Sales
Sales
- Bad Debts
- Sales
- Sales Tax Payable
- Sales Tax Payable
- Sales Tax Payable

24
22

o o o o

95.00
125.00
95.00
695.99
79.99
5.99
324.99
12.36
85.00
55.00
0.00
0.00
8.25%
0.0%
8.25%

ltem v Activites ¥ Reports ¥ Excel ¥ Attach

Figure 2-40 Item List

Step 3.
Step 4.

Step 5.

If the New Feature window opens, click OK.

The Edit Item window opens (see Figure 2-41). Notice this item is linked to the Sales
account. Every time this item is entered on an invoice, it adds the purchase price to

Sales Income.

Close the Edit Item and Item List windows.
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= Edit ltem
TYPE
Inventory Part - | Use for goods you purchase, track as inventory, and resell.

Item Name/Number Subitem of

Camera SR32
UNIT OF MEASURE

Enable...

PURCHASE INFORMATION

Description on Purchase Transactions

Supra Digital Camera SR32

Cost 450.00
COGS Account

Preferred Vendor

50000 - Cost of Goods... ~

Manufacturers Part Number

SALES INFORMATION
Description on Sales Transactions

Supra Digital Camera SR32

Sales Price 695.99

Tax Code Tax -

Income Account 45000 - Sales

ok
Cancel
New Note
Custom Fields

Spelling

Item is inactive

-

[ Cost Account ]

AssetAccount
12100 - Invento...

Inventory Account J [ Income Account J

OnHand #Verage onpo. On Sales Order
Cost

9 450.00 0

0

Figure 2-41 Camera SR32 Edit Item window

QuickBooks Help

Support Resources

QuickBooks provides a variety of support resources that assist in using the program. Some of these
resources are on the Internet and others are stored in Help files locally along with the QuickBooks
software on your computer. To access the support resources, select the Help menu and then choose
QuickBooks Desktop Help, or press F1 on your keyboard. QuickBooks will display context-sensitive
answers to problems you might be having, based on the window you have open. You can also enter a
question and QuickBooks will search its Help Content and the Online Community for related answers.

You can also access Support through messaging and call back options.

Certified QuickBooks ProAdvisors

Certified QuickBooks ProAdvisors are independent consultants, accountants, bookkeepers, and
educators who are proficient in QuickBooks, who can offer guidance to small businesses in various
areas of business accounting. To find a Certified ProAdvisor, select Find a Local QuickBooks Desktop

Expert from the Help menu.

Introducing QuickBooks



34

Review Questions

Review Questions

Comprehension Questions

1. Explain the difference between a QuickBooks working data file, a QuickBooks backup file and a
QuickBooks portable file. How can you differentiate between the three types of files on your
hard disk?

2. Explain the difference between QuickBooks Desktop and QuickBooks Online. What are the
different versions of QuickBooks Desktop?

3. Explain the importance of the QuickBooks Home page.

4. Explain why it is important to enter transactions in QuickBooks using Forms rather than
accounting entries.

5. Describe the primary purpose of accounting in business.

Multiple Choice

Select the best answer(s) for each of the following:

1.

The fundamental accounting equation that governs all accounting is:

a) Netincome = Revenue - expenses.
b) Assets + Liabilities = Equity.
c) Assets = Liabilities + Equity.
d) Assets = Liabilities - Equity.

Which of the following statements is true?

a) Debits are bad because they reduce income.
b) Equity is increased by a net loss.

c) Debits = credits.

d) Assets are increased with a credit entry.

Under accrual accounting;:
a) Asale is not recorded until the customer pays the bill.
b) Income and expenses are recoghized when transactions occur.
c) An expense is not recorded until you write the check.
d) You must maintain two separate accounting systems.

QuickBooks is:
a) A job costing system.
b) A payroll system.
c) A double-entry accounting system.
d) All of the above.

Which is not a method of accessing the data entry screens?
a) Menus
) Home page
) Icon Bar
) Data entry button

o O T
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Completion Statements

1.

As you enter data in familiar-looking , QuickBooks handles the entries for
you.
You should your data file regularly because it is one of the most important

safeguards you can do to ensure the safety of your data.

When you open your working data file, QuickBooks displays the . This screen is
broken into five sections - each dealing with a separate functional area of a business.

are used in QuickBooks Sales forms to represent what the company buys and
sells.

A list which shows all the accounts in your working data file is called the

Introduction Problem 1

1.

‘ Restore the IntroProblem1.QBM file. The password to access this file is Questiva20.

Select Customers from the QuickBooks Icon Bar. This will display the Customer Center.
a) What is the first customer listed on the left of the Customer Center?

Note:

The answer to this first question is AAA Services. If you don’t see AAA Services in the
Customer Center, make sure to restore IntroProblem1.QBM as directed in the box
above. This book uses specific files for each chapter and each problem. If you don’t
restore the correct file, you will have trouble completing the exercises.

b) Inthe Customers & Jobs Center, single click on Mason, Bob. What is Bob Mason’s balance?

c) Click the Date drop down list above Bob’s transaction listing and make sure it says All. How
many transactions do you see, and of what type?

d) Close the Customer Center.

From the Home Page, click the Enter Bills icon. The Enter Bills window opens.

a) Click the Previous button in the upper left corner. What is the name of the vendor displayed
on this bill?

b) What is the Bill Due date on this bill?

From the Home page, click the Chart of Accounts icon to display the Chart of Accounts.

a) What type of account is the Checking Account?
b) How many total accounts are there of this same type?
¢) What is the Balance Total for the Money Market account?

WANT CREDIT?

Join Alicia's companion course at:
http://royl.ws/Questiva-QBDT

Video demonstrations (coming soon!)

Class discussion forums to get your questions answered
Earn CPE / CEUs for using this book

Bonus exercise for each lesson

Have your homework reviewed and graded

Lock in learning with chapter exams




